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If you want to create documents with new and colorful 
formats, Word 2007 offers some interesting options 
with the Quick Styles gallery, a new feature located on 
the Home tab. This gallery contains sixteen templates, 
each available in Live Preview and able to be selected 
with a click. Each style template includes certain fonts 
and font effects, such as color, size, bold or italic, and 
line spacing. The first two styles, Normal and No 
Spacing, apply to the body text in documents; the rest 
apply to parts of documents, such as headings or sub-
headings. The default style, or the one you get if you 
open a new document, is Normal (normal.dotm). In 
2007 the normal template contains several variations 
from the Word 2003 normal template, some of which 
started to bother me the first time I typed with Word 
2007. For one thing, it uses two new fonts, Calibri for 
the body text and Cambria for headings. At an 11 
point size, these fonts seem too small for my older 
eyes. The space between lines in a paragraph (1.15) 
is a bit larger than single space, and the space after 
paragraphs at 10 points seems wastefully large. The 
margins in the new normal template are 1" on each 
side. I prefer smaller margins for most documents. 
This new Normal style is modern and gives a sleek, 
open look to a document, but it’s possible that many 
users moving from Word 2003 to Word 2007 are find-
ing its quirks irritating.  

I decided to try to change the Normal Style in Word 
2007 to be more like the one I was used to in 2003. I 
found several possible approaches to this task, but 
finally settled on a process which worked for me. Be-
low are the steps I used to change Word 2007’s nor-
mal style to one that I preferred: 

First I set myself a plan. I decided that I wanted to 
change only the font, the font size, the space between 
lines in a paragraph, the space allowed before and 
after paragraphs, and the margins. I thought it wise to 
alter only the basics, knowing I could always make 
changes manually for special documents or rework 

the normal template if I wasn’t happy with it. To change 
any of these things, I found I needed to work in a dialog 
box that had a Default button which would save my 
changes for use in future documents. I began by open-
ing Word 2007. On the Home tab in the Font group I 
clicked the dialog box launcher, a tiny arrow in the lower 
right corner of that group. This opened a familiar dialog 
box from Word 2003 containing all sorts of font-related 
options. I changed the font to Times New Roman, 
which, along with Arial, was one of the standards for 
Word 2003. I set the font size to 12 points. I would have 
set it to 10 if I had chosen Arial. These are typical sizes 
for average documents. Then I clicked the Default but-
ton and selected Yes when asked if I wanted this 
change to affect all future documents.  

Then I clicked the dialog box launcher arrow in the 
Paragraph group and set the line spacing to Single 
Space and the Space before and Space after para-
graphs to .6. Again, I clicked Default and answered Yes. 

 

(Continued on page 6) 

Customizing Word 2007 - Creating Your Own 

“Normal” Template  
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The LCACE News Journal is published eleven 
times annually. Members are encouraged to 
submit contributions which will be acknowledged 
in this newsletter. 
Send articles to editor@lcace.org 
Permission is granted to reproduce any or all 
parts of this newsletter in other User Group 
publications, provided that credit is given to 
LCACE and the individual author(s).  
 
The News Journal is produced using a Dell Di-
mension 8300, 512 Plus Troy MICR printer and 
MS Publisher 2010 beta  software.  
L.C.A.C.E  Logo designed By JR. Johnson. 

Lake County Area 
Computer Enthusiasts 

LCACE 
c/o Group Ambassador 

“J.J.” Johnson 

Membership 
 

Membership in LCACE is open to all individuals 
and families interested in personal computing. 
Annual dues are $20.00 per individual/family. 
Associate membership is only $10.00 (out of 
state, unable to attend meetings). Membership 
includes a one year subscription to the LCACE 
News Journal and access to all club libraries and 
functions. Applications for membership may be 
obtained at the monthly meeting, by request on 
the club hotline, and are now available on our 
web site at  - http://www.lcace.org. 

 
 

Meetings 
LCACE meetings are usually held on Saturdays 
at the Grayslake Area Public Library, 100 Library 
Lane, Grayslake, Illinois. The meeting room 
opens at noon and  the formal meeting begins at 
12:30 p.m.  All meetings are open to the public.  
Bring a friend! 
 

 
Advertising 

Ad rates per issue: Full page - $25, Half page - 
$15, Quarter page - $10, Business Card - $5. 
Discounts are available on advance purchase of 
multiple issues. Please send camera-ready copy 
and payment to the club address by the 21st of 
the month preceding publication. For more 
information on ad pricing, please call our Hotline. 
Ads are FREE to all paid members. 
 

 

 Notice 
LCACE WILL NOT CONDONE  or knowingly 
participate in copyright infringement of  any kind. 
The LCACE News Journal is published by and 
for LCACE members. Opinions expressed herein 
are those of the individual authors and do not 
necessarily reflect the opinion of LCACE, the 
membership, the Board of Directors, and/or our 
advertisers. 

mailto:president@lcace.org
mailto:vicepresident@lcace.org
mailto:secretary@lcace.org
mailto:treasurer@lcace.org
mailto:programs@lcace.org
mailto:membership@lcace.org
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Lake County Area Computer 
Enthusiasts' motto is "Members 
Helping members".  Our always 
popular Ask the Gurus and 
Show and Tell highlighted the 
September meeting.  Newslet-
ter editor/president emeritus 
Mike McEnery demonstrated a 
neat program  to organize your 

desktop by creating little "fences"  
ht tp: / /www.stardock.com/products/ fences/
downloads.asp.  Lester Larkin brought an inexpen-
sive webcam he found at Menard's.  
 
Publicity chair Linda Koudelka showed us Picasa, 
a free photo editing program from Google,  
http://picasa.google.com/.  She also mentioned 
http://savemybutt.com ("Help for the computer nov-
ice in all of us").  We discussed the advisability of 
refilling ink cartridges.  The consensus was that 
you are better off buying cartridges made by your 
printer's manufacturer at the best price you can 
find.  A good place to compare prices for just about 
anything sold on the internet is: 
 http://www.pricegrabber.com/.  Patricia Ortseifen 
told us about a program for combining cells or col-
umns in Excel, http://www.asap-utilities.com/.  
LCACE secretary Bobby Jacobs discussed start 
menus http://www.vistastartmenu.com/index.html 
and http://www.tidystartmenu.com/index.shtml.   
 
Internet security always interests everyone.  Vari-
ous antivirus programs were mentioned including 
Microsoft Security Essentials, a free program that 
you can download http://www.microsoft.com/
security_essentials/ 
 
Jay Bitterman reminded us that you can probably 
find anything electronic at Chester Electronics on 
Sheridan Road in Kenosha.  He also told us that 
Ron Forcier at the Upgrade Shop in Wadsworth 
makes house calls to repair computers.   
 
We hope to have SIGs (special interest groups) 
meet occasionally.  Everyone looks forward to 
hearing J.J. talk about digital photography.  Please 
volunteer to lead a SIG.  We can divide our meet-

ing room into sections but need people to lead 
SIGs before we can schedule them.  
 
New member Bart Berndtson has worked with 
computers for many years.  Bart, welcome to 
LCACE.  Guest Julie Bell's specialty is Linux oper-
ating systems.  We hope she will do a program on 
Ubuntu early next year. 
 
Linda Koudelka, who won a package of photo pa-
per, reported that Don Martin is recovering from 
knee surgery and says hello to everyone.  Bill 
Hamilton was our 50/50 winner. 
 
Eric Rehberger will now pick up First Glimpse 
Magazines from Best Buy, and vice president 
Linda Busch will arrange for refreshments each 
month.   
 
 
Mark your calendar for our upcoming meetings : 
 
October 9-Virtual machines by Julio Rivera and 
Fred Barnett 
 
November 6-Robin Seidenberg will present “My 
Uncle, the Hollywood Producer” which the Grays-
lake Area Public Library will co-sponsor 
 
December 4-Holiday party-State Bank of the Lakes
-1-5 p.m. Save the date! 
 
January 8, 2011-Show and tell and ask the gurus 
 
February 12, 2011 
 
March 12, 2011 
 
Do you have ideas about programs you would 
like?  Please contact Julio Rivera, 
 programs@lcace.org, or email me at: 
president@lcace.org. 
 
2010 holiday raffle tickets will be available for sale 
at our October meeting.  In addition to buying tick-
ets for yourself, please plan to pick up tickets to 
sell.  The person who sells the winning first prize 
ticket and also the person who sells the most tick-
ets will receive prizes at the holiday party. 
 
This year we will have five holiday raffle prizes.  
Our big prize is a 17" HP laptop with 4GB RAM 
and a 320GB hard drive.  Second prize is a 10" 
Acer netbook with 1GB RAM and a 160GB hard 
drive.  An 8GB Apple iPod Touch is our third prize.  
Fourth prize is a VuPoint Magic Wand Scanner.  

(Continued on page 4) 

Robin’s  

RAMblings 

http://www.stardock.com/products/fences/downloads.asp
http://www.stardock.com/products/fences/downloads.asp
http://picasa.google.com/
http://savemybutt.com
http://www.spcug.org/
http://www.asap-utilities.com/
http://www.vistastartmenu.com/index.html
http://www.tidystartmenu.com/index.shtml
http://www.microsoft.com/security_essentials/
http://www.microsoft.com/security_essentials/
mailto:programs@lcace.org
mailto:president@lcace.org


4 

Last but not least, fifth prize is a one year member-
ship to LCACE. 
 
Tickets are $1 each; 6 for $5, and 25 for $20.  The 
more tickets you buy, the better your chances of 
winning one of these fabulous prizes.  Winners  
need not be present so plan to sell tickets to out of 
town family and friends.  
 
It's that time of year again.  If you are in the market 
for new technology, Dealnews.com has published 
their annual Black Friday predictions 
http://dealnews.com/features/The-dealnews-2010-
Black-Friday-Predictions/389192.html.  Their rec-
ommendations for this holiday season include:  
Don't buy a 3D TV.  They say to wait two years 
until there is more content and prices come down.  
They predict a low price of $179 for a 10" netbook 
on Black Friday.  There are no longer many deals 
on desktop PCs.  Although blu-ray disk players 
have not come down much in price this year, they 
are losing relevance because people are turning to 
online streaming video.  According to the site there 
will be few buys on Apple products. 
 
Dealnews predicts that Black Friday will be a great 
time to buy a large capacity hard drive.  "Expect to 
find 2TB USB 2.0 external hard drives for $74, 
which is under 4 cents per GB."  They have no 
predictions on LCD monitors this year "because 
external monitors have waned in popularity."  The 
best way to get a good buy on an e-book reader 
will be to buy a refurbished discontinued model. 
They forecast a $99 price on Nintendo Wii 
(Remember these are Black Friday's lowest 
prices!).   
Their final bit of advice:  Be choosy about when 
you buy. 
Happy computing! 

(Continued from page 3) 

 

Hewie's Views & 
Reviews  
By Hewie Poplock 
Central Florida Computer Society 

Remove Time Stamps from Photos, Rename & 
Change File Date 
  
I am the webmaster for several websites. I have 
photos submitted to me regularly to be posted. 
Sometimes the photographer submits the pictures 
with a date stamp, which is great for identifying 
your personal photos, but it does not belong on 
those appearing on the web. 
  

In most cases, it only appears on the photo be-
cause the camera owner did not realize that it was 
set that way, or they did not know how or even that 
they could turn that "feature" off. 
  
If you don't have the proper date set in the camera, 
the date stamp will be wrong, as were several that 
I recently received. They showed a date that was 
over 3 years prior to the event, so I needed to re-
move them from the photos. Have you tried this? It 
is not easy, unless you continue reading. 
  
My first thought is to crop the photos to eliminate 
the date. Most of the photos would lose some im-
portant pieces if I did that. I have several photo 
editing programs that I could edit the date stamp 
out. It is very time consuming and while it can be 
done, it was going to take more time than I wanted 
to devote to the project. 
  
My next step was to Google the problem. I tried 
several combinations of terms including time 
stamp. There were lots of results, but most had 
little to do with removing the date. Many of them 
told me how to place it, but not remove it. 
  
The most informational results were from forums 
where users were asking for the same solution. 
The most frequent response was "change the set-
ting in the camera." DUH! Of course. What about 
the pictures that were already taken? I did find 
some good tutorials using Photoshop and other 
editing programs. I was still looking for a tool or 
hint to make it easy. Surely, I wasn't the only one 
with the problem. 
  
I figured if there were simple steps to get rid of the 
red eye, certainly there is a way to get rid of a date 
stamp. In one of the forums, someone suggested 
Photo Stamp Remover by http://softorbits.com. 
This program appeared to be what I was looking 
for, and then some. According to their website, 
"Photo Stamp Remover is a photo correction utility 
that can remove scratches, dust, stains, wrinkles, 
tears, date stamps and other unwanted artifacts 
that appear on photographs. With Photo Stamp 
Remover, you can restore photos with the mini-
mum of fuss." 
  
I downloaded, installed, and ran the program, us-
ing the pictures that I received. In almost every 
case, the date stamp was removed and did a rea-
sonable to a great job. The trial version does not 
do batches, but the paid version does and it works 
well, with 2 settings, quick, or thorough. The latter 
did a better job. 

(Continued on page 6) 

http://dealnews.com/features/The-dealnews-2010-Black-Friday-Predictions/389192.html
http://dealnews.com/features/The-dealnews-2010-Black-Friday-Predictions/389192.html
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Lake County Area 

Computer Enthusiasts 
“Members Helping Members” 

(since 1983) 

1st Prize: 

 

HP 17" Notebook  
Core Duo T6600  processor 
4GB of RAM 
320GB hard drive 
Webcam and microphone 
Lightscribe Super Multi Dual layer DVD±R/RW 
Windows 7 

2nd Prize: 

Acer Aspire One 
10.1” Netbook  

Intel Atom N450 
1GB of RAM 
160GB hard drive 
Windows 7 starter 

5th Prize:  

1-Year’s Membership LCACE  
“Members Helping Members” 

Tickets: $1 each, 6 for $5, or 25 for $20 
 

Drawing December 4, 2010 
WINNER NEED NOT BE PRESENT 

3rd Prize:  

Apple iPod Touch-8GB 
A great music and video player, pocket 
computer and thousands of other uses. 

 
4th Prize:  

VuPoint wand scanner 
Fast and convenient way to scan, archive and 
organize for your personal use. 
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The program is a bit pricey at $40, but well worth 
it. A normal procedure for me is to search for cou-
pons before making a purchase. I did so for this 
program and found a coupon at http://
www.tjoos.com/ which is a coupon posting site. It 
was a 20% off code, which saved me $8. 
     
While removing the date stamp, I also wanted to 
change the file names and not use the ones that 
the camera uses. For that I use a tool that I wrote 
about in a previous column, Lupas Rename http://
rename.lupasfreeware.org/ which is free. It is an 
old program going back to 2005, but it still installs 
and works on my Windows 7 computer. You can 
rename batches, changing, adding to, or number-
ing sequentially. You can change the case of the 
file filename and extension. I prefer to have my 
photos all in lower case. 
  
However, Lupas Rename does not change the file 
date. I had all of these pictures with the wrong date 
stamp, but also the file date was wrong. While 
there are ways to change file dates, there must be 
a tool to do this in a batch. Back to Google. I found 
Attribute Changer from http://petges.lu [4] which is 
a free tool. It is a power user tool to change file 
and folder attributes, date, time, NTFS compres-
sion, and even changes the Exif information. It 
runs in the Windows Shell, which allows you to 
right click in Windows Explorer and choose 
"Change Attributes." Its dialog box opens and you 
make your changes. 
  
With these tools, I can make changes to several 
photos at once. I can change the file names using 
a title and numbering them sequentially, remove 
the time stamp, and then change the file date at-
tribute. Now that's what computers were designed 
to do. Make tasks simpler. 

(Continued from page 4) 

DigitalCorner 
 
Four Rules of Composition 

Thirds 

Rule of odds 

Rule of space 

Viewpoint 

Need to know more, ask your 

club’s photography Guru. 

Next, I clicked the Page Layout Tab, and, in the Page 
Setup group, clicked the Margins button, which gave me 
a list of margin schemes, including diagrams of each. 
Even though I wanted the Narrow margin scheme, I 
knew just clicking it would not make it hold for future 
documents, so I clicked Custom Margins at the bottom 
of the list. Sure enough, up came a dialog box with a 
Default button. I made sure .5" replaced 1" in all four 
boxes, then clicked Default and Yes. 

My last step was to go back to the Home tab and right 
click the Normal style icon, then Modify. In the Modify 
Style dialog box, I clicked the radio button next to “New 
documents based on this template.” This dialog box is a 
good place to see a preview of what your next docu-
ment will look like and to confirm that the changes 
you’ve made are listed beneath the preview window. 
You might be puzzled by the “widow/orphan” item in the 
list, but don’t eliminate it unless you have a specific rea-
son to. The widow/orphan control keeps the last line of 
a paragraph (a widow) from appearing alone at the top 
of a page and the first line of a paragraph (orphan) from 
appearing alone at the bottom of a page.  

When my modifications were complete, I clicked OK to 
close the Modify Style dialog box, pretty confident that 
my changes had taken effect. I decided, however, to 
create a new document at this point to see for myself if 
it would conform to my specifications. I knew if some-
thing were incorrect, I could always go back through the 
steps to fix it. But all was well. I now have my new Nor-
mal style and am liking Word 2007 better and better. : 

 

Copyright 2010. This article is from the August 2010 
issue of the Sarasota PC Monitor, the official monthly 
publication of the Sarasota Personal Computer Users 
Group, Inc., P.O. Box 15889, Sarasota, FL 34277-1889. 
Permission to reprint is granted only to other non-profit 
computer user groups, provided proper credit is given to 
the author and our publication. We would appreciate 
receiving a copy of the publication the reprint appears 
in, please send to above address, Attn: Editor. For fur-
ther information about our group, email: 
admin@spcug.org/  Web: http://www.spcug.org/   

(Continued from page 1) 

mailto:admin@spcug.org/
http://www.spcug.org/
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Henry Henriksen 
Marshia Hobson  
Carolyn Lewis  

Eric Rehberger  
Ellen Smatlak 

Time to clean out your closet. Bring it to the meeting and place 
it on the FOR SALE or FREEBIE tables. All items placed on the 
FOR SALE table MUST have your name and asking price at-
tached to it. If you just want to get it out of your closet, then 
place it on the FREEBIE table and hope one of your club mem-
bers has a better home for it. All items not sold or taken must be 
reclaimed by the end of the meeting. 

 

 

 

  

 

 

Your article or thoughts could have 

been placed here.  Please support 

your News Journal. 
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Vista Start Menu 
Submitted by: Bobby Jacobs  
 

http://www.vistastartmenu.com/
index.html  
Vista Start Menu is the convenient 
alternative to the plain Start menu 
you find in Windows XP and Win-
dows Vista. The program uses your 
cognitive abilities (visual memory, 

reflexes,etc.); however, while it is easily under-
standable for beginners, it is also highly efficient 
for experienced users.  I use it to keep track of my 
programs.  Each time I add a new program, I put it 
in a folder so to speak.  If I add a program for 
working with audio files, I put it under audio.  Then 
I never have to figure 
out what the file does.  
You can add the vari-
ous folders as you want 
and move files between 
the folders.  Or you 
could have the same 
program in two folders.  
When I add the pro-
gram, sometimes I have 
the choice of where to put it on the start menu.  If I 
don’t have the choice, I just move it to the right 
place. 
 
http://www.tidystartmenu.com/index.shtml       
        I started by trying the Tidy Start menu.  It is 

quite similar and probably helped for the de-
velopment of the vista start menu.  You should  
probably start with this first also because it 
has the various folders set up. 

 
 

ASAP Utilities 
Submitted By: Patricia N. Ortseifen 

 
 This is a free program for Excel 
that allows combining columns/
cells without the need of a for-
mula. You can also uncombine 
them if necessary. There are also 
other options. 
  

 http://www.asap-utilities.com/index.php 
 
 

Stardock FencesUtilities 
Submitted By: Mike McEnery 

 
This free program is ideal for people who need to 
bring order or just organize their Windows desktop. 
  http://www.stardock.com/products/fences/ 
 

Free photo editing Utilities  
Submitted By: Winnie Frost 

 
Available online at citrity.com 
where your uploaded photos can 
be tweaked with nifty effects like 
teeth-whitening and wrinkle remov-
ing.  Pixorial .com provides free 
video online editing and up to 10 
gigabytes of free storage. 
Save on printer ink 

Use the Century Gothic font which a recent study 
showed consumes about a third less ink than in-
dustry standard Arial.  That saves about $20 a 
year for home users printing 25 pages a week. 
Volunteer techies 
Give free advice on common computer problems 
at http://www.fixya.com/ 

“MeMbers Helping MeMbers” 

Tips Smart Computing 
• Ereaders Offer Digital Convenience: Ereaders 
can bring you books, blogs, and the Web wherever 
and whenever you need them. New electronic ink 
displays are easy on the eyes and provide a natu-
ral and familiar reading experience. And on models 
with Wi-Fi or 3G capabilities, you can shop right on 
the device: Select and pay for your purchase, and 
you can be reading your new book or magazine 
w i t h i n  a  m i n u t e  o r  t w o . 
 
• Upload Photos & Videos To A Digital Frame: 
The process of uploading photos and videos to a 
digital frame depends on what type of frame you 
have. Traditional frames require you to save pho-
tos on a USB flash drive or memory card and con-
nect it to the frame. Wireless digital frames can 
stream pictures from your computer or online shar-
ing sites over your wireless home network  
"Reprinted with permission from Smart Computing. Visit 
www.SmartComputing.com/Groups to learn what 
Smart Computing can do for you and your user group!"  

http://www.vistastartmenu.com/index.html
http://www.vistastartmenu.com/index.html
http://www.tidystartmenu.com/index.shtml
http://www.asap-utilities.com/index.php
http://www.stardock.com/products/fences/
citrity.com
Pixorial%20.com
http://www.fixya.com/
http://www.smartcomputing.com/groups
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Take a good 

look, you just 

might see  

yourself. 

http://lcace.org/PhotoAlbums.htm 

 Members 

LCACE  

Phone: 847.623.3815 
Web Site:  http://
www.lcace.org 

 
 Alleman, Elizabeth esa2204@aol.com 

Anderson, Jean jande77893@aol.com 

Barnett, Fred :BNSCom@aol.com 

Becht, George pechmem-gen@yahoo.com 

Berg-Wells, Lois luludefl@yahoo.com 

Berndtson, Bert bartb64@yahoo.com  

Berry, Bob & Tracy mgd2race@yahoo.com 

Bitterman, Jay bittjayl@aol.com 

Busch, Linda lindashrub@att.net 

Ditman, Bill william.ditman@comcast.net 

Frost, Jack Jfrost13@sbcglobal.net 

Frost, Winnie wfrost13@sbcglobal.net 

Halley, Jack jack96@aol.com 

Hamilton, Bill hamiltonbill24@comcast.net 

Hanlon, Terri terhanlon@comcast.net 

Henriksen, Henry hhenriksen@wi.rr.com 

Hesse, Gary pocanada@sbcglobal.net 

Hobson, Marshia omsgadget@yahoo.com 

Jacobs, Bobby bobj2361@gmail.com 

Johnson, Dwight (J.J.) jj1450xl@yahoo.com 

Kalinoski, Donna donnaleek@juno.com 

Kline, Cherie catmom1001@aol.com 

Kostelnik, Steve steve_kostelnik@usa.net 

Koudelka, Linda & Robert koudelka3@comcast.net 

Kusiak, Joseph juj014@att.net 

Lagoni, Doreen bearmagic1999@aol.com 

Larkin, Lester LesLarkin@aim.com 

Lewis, Carolyn lewis.linwood@att.net 

Martin, Donald dmartin339@comcast.net 

McEnery, Mike mmcenery@sbcglobal.net 

Ortseifen, Patricia patricia@ortseifen.com 

Rehberger, Eric graduates63@gmail.com 

Rivera, Julio jlrivera@db3mail.com 

Rudnit, Harriet hrudnit@yahoo.com 

Salsburg, Leslie leslie164@juno.com 

Seidenberg, Lew drlew1@aol.com 

Seidenberg, Robin anguslechat@aol.com 

  

  

  

  

  

  

If you have a Web Site 
and would like to advertise it here, 

e-mail me at 

lcaceeditor@sbcglobal.net 
 

www.pegasusphotos.zenfolio.com 
 

www.pegasusphotos.net 
 

www.johnsonbarnes.org 
 

www.RobinSeidenberg.com  

Smatlak, Ellen emsmis@hotmail.com 

Straw, Gerald gkstraw@comcast.net 

Sturek, Jorja jksturek@sbcglobal.net 

Sutherland, Dorothy deedee1938@yahoo.com 

Urh, John johnurh@sbcglobal.net 

Wagner, Richard & Belinda SenoritaBW@AOL.com 

Wells, Alden alden_racing74@yahoo.com 

Welcome Bert Berndtson to LCACE 

http://lcace.org/PhotoAlbums.htm
http://lcace.org
http://lcace.org
mailto:esa2204@aol.com
mailto:jande77893@aol.com
mailto:BNSCom@aol.com
mailto:pechmem-gen@yahoo.com
mailto:luludefl@yahoo.com
mailto:bartb64@yahoo.com
mailto:mgd2race@yahoo.com
mailto:bittjayl@aol.com
mailto:lindashrub@att.net
mailto:william.ditman@comcast.net
mailto:Jfrost13@sbcglobal.net
mailto:wfrost13@sbcglobal.net
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mailto:jksturek@sbcglobal.net
mailto:deedee1938@yahoo.com
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Serving Lake County, Illinois 

Since 1983 

Visit us @ http://www.lcace.org 

NEXT NEXT NEXT MEETINGMEETINGMEETING   

November 6, 2010 

Lake County Area Computer Enthusiasts 
409 S. Elmwood Avenue 
Waukegan, IL 60085 

POSTAGE 

REQUIRED 

October 9, 2010 

at the Grayslake Area Public Library 

 

By 

Robin Seidenberg 

Virtual machines by 

Julio Rivera and Fred Barnett 

http://www.lcace.org

